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About this Document

Intended Audience
This document is intended for Planon Software Suite users.

Contacting us
If you have any comments or questions regarding this document, please send them to: 
support@planonsoftware.com.

Document Conventions
Bold
Names of menus, options, tabs, fields and buttons are displayed in bold type.

Italic text
Application names are displayed in italics.

CAPITALS
Names of keys are displayed in upper case.

 

Special symbols

Text preceded by this symbol references additional information or
a tip.

Text preceded by this symbol is intended to alert users about
consequences if they carry out a particular action in Planon.
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About Connect for AutoCAD

Connect for AutoCAD is a plug-in that is integrated into AutoCAD and enables AutoCAD
users to maintain Planon ProCenter data in their CAD drawings.

Connect for AutoCAD is a part of Planon CAD Workbench Solution which also contains
CAD Import. CAD Import is available as a launch group within Planon ProCenter and
enables users to import the (changed) data from Connect for AutoCAD.

Prerequisites for Connect for AutoCAD
• Connect for AutoCAD must be installed.

 
See Connect for AutoCAD - Installation Guide.

To run the registered, installed version of Connect for AutoCAD, the following
requirements must be met:

• Users must have Planon ProCenter logon credentials. Users will be
prompted to log on to Planon ProCenter while using certain features in
the plug-in.

• CAD Workbench is required to be able to work with Connect for
AutoCAD.

• Drawings must be imported at least once by CAD Import in Planon
ProCenter.

• The Connect for AutoCAD tool needs the JsonServices product
definition to function properly. Without it, an error message will be
displayed that the URL is invalid. You can link the JsonServices
product definition to a user in Authorization > User Groups.

R u n n i n g  C o n n e c t  f o r  A u t o C A D
1. Right-mouse click in an opened AutoCAD drawing.
2. Select Connect for AutoCAD.
3. Select Settings.
4. On the General tab, enter the Planon ProCenter URL.

For example:

http://WebServerName:portnr/sdk

or, for Cloud environments:
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https://yourenvironment.planoncloud.com/sdk/

5. Click Save.
6. Close AutoCAD and reopen it.
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Connect for AutoCAD - Concepts

The following concepts are explained in this section:

• Assets

• Mapping

• Move box

• Palette

• Persons

• Planon ProCenter connectivity

• Polyline

• Property set

• Reference data in Connect for AutoCAD

• Rentable units

• Spaces

• Workspaces

Assets
An item such as property or object of value that is owned by a person or an organization.

An Asset is linked to a property in Planon ProCenter. Assets are classified as simple
and multiple in Planon ProCenter, however, Connect for AutoCAD only supports simple
assets.

 
The term assets in this document only refers to simple assets. Multiple assets are not
supported.

Mapping
An operation that associates elements of the same type in a given domain.

Mapping in Connect for AutoCAD is a feature that groups Planon entities having the
same data, by using the same hatch and color in the drawing. It helps you to track the
entities usage.

When a mapping is performed on Available workspaces (drawing) and Available
workspaces (Planon) in a drawing using Connect for AutoCAD, a fixed coloring is
applied based on the available workplaces as mentioned below, along with the available
workplace information.
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Red: the available workplaces are over-occupied.

Orange: All workplaces are occupied.

Yellow: Partially occupied workplaces.

Green: No workplaces are occupied.

 
Mapping information for Available workplaces (drawing) is displayed on the palette since
this is also a visible field on the palette.

Move box
A carrier of person and/or asset information from one drawing to another.

In Connect for AutoCAD, a move box is a file containing person and/or asset information
which is used to move persons from one space in a drawing to another space in another
drawing.

Palette
The Palette is a window in the AutoCAD tool.

The Connect for AutoCAD palette displays the loaded information of a selected Planon
ProCenter entity and allows you to modify the data.

The palette has various features such as:

• filtering items

• mapping entities, by multi-colored highlighting (based on usage)

• move entities from one drawing to another using the move box, and so
on

It also allows you to convert the selected polyline as a space/rent to/rent from unit and
link a polyline as a net or gross polyline to the selected entity.

 

Working with the palette

Persons
An employee in an organization.

In Planon ProCenter, a person is an entity. You can manage person data in Personnel
Management. However, using Connect for AutoCAD, you can add or move persons from
one floor to another graphically.
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Planon ProCenter connectivity
Connect for AutoCAD allows you to connect to a version of Planon ProCenter.

Users are prompted to log on to Planon ProCenter while using certain features in
Connect for AutoCAD. Otherwise, most of the features can be used without connecting to
Planon ProCenter.

Polyline
Represents the net area or the gross area of floors, spaces, flexible workspaces, rent to
units or rent from units and assets.

Property set
A data set that consists of specific properties (buildings).

Depending on the authorizations of their user group, Planon ProCenter users can view or
work on various property sets.

In Connect for AutoCAD, you cannot view or edit the property set for your spaces. On
connecting to Planon ProCenter, the property set of the logged-on user will be used for
retrieving the data. Therefore, we recommend that you use only one property set within a
drawing.

 
For more information on property sets, refer to Fundamentals.

Reference data in Connect for AutoCAD
In Connect for AutoCAD, the descriptions of entities are usually changed in the drawing.
However, you can also update the description of entities with Planon ProCenter data,
using the Update all reference data feature. The descriptions of departments, cost
centers, addresses, spaces and so on are updated in the drawing after a connection is
established with Planon ProCenter. See Updating the reference data in a drawing for
information on this feature.

Rentable units
A rentable unit is (a part of) a property that can be leased or subleased as an undividable
entity. A rentable unit is always linked to a property. A rentable unit can be a hierarchical
element.
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In Planon ProCenter, the Rentable Unit Management TSI enables you to register and
manage rentable units.

Rentable units you have registered in the Rentable Unit Management TSI can be linked
to a (lease) contract in the Contract Management TSI.

A maximum of two levels can be defined.

There are two types of rentable units:

• Rentable units rented out to another party – Rent to

• Rentable units rented from another party – Rent from

• Connect for AutoCAD supports both the Rent to and Rent from types
of rentable units.

The life cycle concept enables you to keep track of changes that have been
made to a rentable unit in the course of time.

 

Loading Planon ProCenter data

Spaces
Spaces can be rooms, offices or specific places on a floor in a property. The space can
be used as a place to work or be part of a 'rent to unit' or 'rent from unit'.

A space in AutoCAD is represented by a polyline that is marked as space and also holds
the space related data. Polylines and data are a part of the AutoCAD drawing.

In Planon ProCenter, the Space Management TSI is designed to facilitate the effective
usage of your spatial resource. It can be used to register and retrieve all kinds of data
concerning to conference rooms, offices and other (work) spaces of your building.

After making changes for a drawing in Connect for AutoCAD and offering that drawing
to CAD Import, you can track the changes in Space Management. All the changes that
you make are created as new records for Space size and/or Space usage starting on the
specified “date of import” in the CAD import definition.

Connect for AutoCAD cannot deal with spaces that have more than one space usage at
the same time. So if you execute the function Load Space data, only spaces that have
one space usage on the reference date will be loaded.

 

Loading Planon ProCenter data

Workspaces
Work area allocated to employees in an organization to conduct their work related
activities.
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A workspace in Connect for AutoCAD is a space that can be allocated to a person
within a space in the drawing. The Available workspaces field displays the number of
workspaces in a selected space that are vacant in a drawing.

This field is calculated based on the difference between the field Number of fixed
workspaces in Connect for AutoCAD and the Number of People located in that space in
the drawing.

Workspaces 13



Working with Connect for AutoCAD

The Connect for AutoCAD menu helps you to work with the Planon ProCenter data in
the AutoCAD drawing.

 
A drawing, apart from the graphical representation of Planon ProCenter entities such as
spaces, rentable units, and persons, also contains a copy of the Planon ProCenter data.
This data can be loaded into the Planon ProCenter database by using CAD Import.

Connect for AutoCAD includes:

Working with the Palette

Loading Planon ProCenter data

Synchronizing the entities location from Planon ProCenter

Moving entities

Copying entities

Inserting entities into a drawing

Managing assets by filtering on classification group

Analyzing drawings

Deleting Planon ProCenter data (Purging)

Configuring settings

 
The term “entities” is used in this document to collectively represent Planon ProCenter
entities such as Spaces, Persons, Assets, Rent to units and Rent from units.

Working with the palette
You can use the palette to view or modify entity data, create filters and mapping, move
entities from one drawing to another, load entities from Planon ProCenter and much
more.

P r o c e d u r e
1. Start AutoCAD. In the AutoCAD drawing window, right-click to open the

Context menu and point to Connect for AutoCAD.
2. Select the Palette option.
3. By default, the palette appears on the left of your Drawing window.
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1 Indicates which type of polyline can be selected in Spaces and Rent to units
and Rent from units only.

2 Indicates the number of entities selected and their total area.

3 Contains buttons to perform relevant actions in Connect for AutoCAD.

4. Select either the Spaces, Persons, Assets, Rent to units or Rent from
units tab.

5. In the Selection area, select either Net or Gross in order to work with
the net or gross polylines of Spaces/Rent to units/Rent from units.

6. Select an entity in the drawing.
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You can now view/edit the entity’s data in the palette.

The following table describes the functionality of various buttons of the palette:

Button Action

Enables you to create or edit a filter, mapping move
box and data block link. Also allows you to enter a
comment on an entity.

Applies the selected filter or mapping in the drawing.

Deletes the selected filter, field data or mapping or
move box.

Displays a list of values to be inserted in the
reference field.

Clears the entities on the Planon Mapping layer.

Converts net polylines to a Planon entity.

 
The Create button can only be used if you draw a new
polyline. If you copy an existing space polyline and
use either the Link or the Create button it will result in
incorrect data.

Links a gross polyline to a net polyline which both
belong to the same space.

 
See the warning in the above Create button
description.

Removes Planon ProCenter data from the polyline.

Specifies a new insertion point for the text of an
entity.

Clears the insertion point specified using the text
point button.

Adds an entity to the selected move box.

Copies data of Department and Cost center fields
from spaces to persons or assets.

Copies data of Department and Cost center fields
from persons or assets to spaces.
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If you make any changes to the Windows Display Properties, make sure you restart
AutoCAD to reflect these changes. The Connect for AutoCAD layout is only supported with
a DPI Setting of 96 DPI.
Connect for AutoCAD does not support drawings that have XRefs. You can select the
relevant Planon entities for loading and synchronizing from the main drawing only.

 

Palette

Keyboard actions on the palette

• CTRL+Z – to undo the last modification of a field value

• CTRL+A – to select all the entities in a drawing

• CTRL+(switch from one entity tab to another) – to display a group
of related entities as selected in a drawing while switching from one
entity tab to another.

Example: A drawing consists of persons and spaces. Select the group
of the spaces that belong to a certain department in the drawing.
Press CTRL and switch to the Persons tab on the Palette. All the
persons that are located at that moment in the spaces that have been
selected in the Spaces tab are now selected when you switch to the
Persons tab.

• CTRL+(Select filter) – to apply a filter on the entities that have already
been selected or filtered in a drawing.

Example: Select a set of spaces in a drawing. To apply a filter on the
department name for selected spaces, press CTRL and select the
department name filter from the filter drop-down list on the Palette.
Spaces are now selected based on the department name filter in the
drawing.

• CTRL+(switch to Assets tab) – to display the assets as selected for
the persons selected on the Persons tab.

Example: On the Persons tab, select a set of persons in a drawing.
Press CTRL and switch to the Assets tab. The assets that are owned
by one of the selected persons (Of person field) are selected in the
drawing.

• CTRL+(switch to Persons tab) – to display the persons who are
referenced from the Of person field on the Assets tab for the selected
assets.

Example: On the Assets tab, select a set of assets in a drawing.
Press CTRL and switch to the Persons tab. The persons referenced
in the Of person field for the selected assets on the Assets tab are
selected in the drawing on the Persons tab.

Keyboard actions on the palette 17



• At any time, if you want to add or sort pre-existing fields on the
Palette, go to Settings and select the relevant entity tab.

Modifying field values

You can modify a value in an entity field:

P r o c e d u r e
1. In the Fields area, click the  icon in a field. The relevant dialog box

of the field appears.

For example, the Cost Center dialog box. Select a cost center
and click OK.

 
By default, the list only contains values that have already been used in this drawing.
To view more values from Planon ProCenter, click More… You can filter the values from
Planon ProCenter by using the Search option. This field accepts the following wildcards:

• % , for multiple characters

• _ , for a single character

Or
Enter the relevant value in the fields such as Department,
Cost center, Space type and so on, without having to choose
from the reference list. A connection is established with the
Planon ProCenter database if necessary to validate the
value you have entered.

2. Enter a new value in the string field such as Name or Space number.

Enter a new value in the integer field such as Number of
workspaces.

3. Enter a new value in the decimal field such as Height.
4. Enter a new value in the date field.
5. Click Save in AutoCAD to save the drawing and the Planon ProCenter

data in the drawing.

You have now modified a value on the Palette and saved it in the AutoCAD drawing.

Creating filters

A filter can be created, applied and deleted. It helps you to search for an entity and work
on its data accordingly.

P r o c e d u r e
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1. In the Selection area, click  (Add/Edit Filter).

The Filter details dialog box appears.

2. In the Filter name field, specify a name for the filter.

 
By default ‘=’ is displayed in the fields of the dialog box.

3. In the Fields area, select relevant operators per field and enter field
values.
Refer to the following table for more information on operators:

Field type Available operators

String fields

Example: Name and Space
number

=, Contains and Is empty

Reference fields

Example: Department and
Cost Center

= (single value)

In (multiple values) and Is empty

Integer fields

Example: Number of
workspaces

=, <, >, =<, >= , Is empty and Between

Decimal fields

Example: Height

=, <, >, =<, >=, Is empty  and Between

Date fields

Example: Start date and
end date

=, <, >, =<, >=,Is empty and Between

For example, if you use the In operator, click  in the
relevant field. The In dialog box appears.
In Available, select a single field and double-click to move it
to In Use.
Or
Select multiple fields and click the right arrow to move the
items to In use.

 
In Available, click More… to add more values from Planon ProCenter.

In In use, you can view the selected fields.
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Click OK.

 
If multiple fields are selected *VARIES* is displayed in the selected field.

4. Click Save. You have now created a filter.

 
When you select a filter (Space, Assets, Person etc), the filter name in the dropdown box
is highlighted (in red color) to indicate that the filter is active. In such a case, you can only
select the elements that are relevant to the active filter in the drawing.

5. Click  (Apply filter) to apply a filter. Based on the filter criteria, the
relevant items are selected in the drawing.

 
The created filters, mappings, logging and block definitions are by default saved in or
deleted from: 

Filters: C:\Documents and Settings\<User directory>\Application Data\Planon\Planon
Connect for AutoCAD\Filters. 

Mappings: C:\Documents and Settings\<User directory>\Application Data\Planon\Planon
Connect for AutoCAD\Mappings. 

Logging: C:\Documents and Settings\<User directory>\Application Data\Planon\Planon
Connect for AutoCAD\Logs 

Block Definitions: C:\Documents and Settings\<User directory>\Application Data\Planon
\Planon Connect for AutoCAD\BlockDefinitions

Creating mapping

A mapping can be created, selected, deleted and cleared. The Mapping option helps you
to highlight the entities which are having the same usage.

 
If your drawing contains unclosed polylines that represent Spaces, Rent to units or Rent
from units, then the outcome of area calculations, available workspace calculations and
copying data from and to spaces might be incorrect. We recommend that your drawing
contains only closed polylines.

P r o c e d u r e
1. For mapping text fields area, click  (Add Mapping). The Mapping

Details dialog box appears.

Refer to Mapping fields for a description of various fields which are available in the dialog
box.

2. In the mapping text fields section, you can select the relevant fields
to display their data in the drawing after mapping is performed.
Additionally, you can check the Show details for reference fields option
to display the Code (or) Code Group (or) Description (or) Code Group
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and Description for these reference fields along with the default list of
reference fields.

1. In Available, select fields to display information specific to an entity in the drawing.
2. Select an item in Available and double-click to appear in Visible.
3. Select multiple values and click the right arrow to move them to Visible.
4. Sort the items in Visible the way you want to view them in the entities of a drawing.
5. Select Display colors in background to see the mapping text highlighted by a background

color matching the mapping color of the entity. The mapping text is then displayed in white
or black depending on the background of the drawing.

3. Click Save.
4. Select the entities for which you want to apply a mapping or press

CTRL+A to select all the entities in a drawing.
5. On the Palette, in the Mapping field, select a mapping to apply. Click 

(Apply mapping).

You have now applied the selected mapping.

 
You can reposition the legend using the Settings > Mapping > Legend insert point option.

When a mapping is applied, a new layer is created. Make sure not to draw on this layer
since the data on this layer will be erased when a new mapping is applied.

If you apply mapping on a large number (in hundreds) of entities, it may take several
minutes for the mapping to complete.

Specifying a text insertion point

You can specify the text location of an entity using this feature, such as the name of a
department. The text point can be set outside an entity if the entity is too small to display
the mapping text. You can easily identify the relevant text of an entity with a line which is
connecting.

P r o c e d u r e
1. Select an entity tab.
2. Select a single entity or multiple entities. The Text Point button on the

palette becomes available. Usually, the text point for a single entity is
specified. However, if you selected multiple entities, the new text point
will be applied for all of them.

3. Click Text Point to specify a new location for the mapping text to display.
4. Apply mapping or use Automatically highlight current selection in the

settings dialog box to verify your entity’s text location.

You have now displayed the mapping text in the specified location.
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Clearing a text insertion point

You can clear the text insertion point so that the mapping text will be displayed on the
default position of the entity.

P r o c e d u r e
1. Select the entities whose text insertion point you want to clear.
2. Click Clear on the palette.
3. Apply a mapping to test your text location. You have now cleared the

text insertion point.

Converting polylines into Planon ProCenter entities

You can convert a polyline in a drawing into a Planon ProCenter entity such as Space,
Rent to units or Rent from units.

This feature has two options:

• Create: Select polylines and convert them as Space, Rent to units or
Rent from units. The current setting of net or gross defines what type
of polyline it will become.

• Link: Select a Space, Rent to units or Rent from units and link a
polyline to it as a net or gross polyline.

 
In order to create a new space or to link a new space to the existing entity in a drawing,
execute Load Space data… at least once.

Procedure

1. On the Palette, select the Spaces or Rent to units or Rent from units
tab.

2. Select either the Net or Gross option.
3. In the bottom area of the palette, click Create.
4. On the drawing, select a polyline and do right click or press Enter. You

can also select multiple polylines to convert them into Planon ProCenter
entities.

5. On the warning message box, click Yes. This converts the selected
polyline into Planon ProCenter entity.

6. On the information box, click OK.

The created entity is selected.

Linking a net polyline to a gross polyline
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P r o c e d u r e
1. Select the Spaces, Rent to units or Rent from units tab for which you

want to link a net polyline to a gross polyline.
2. Select the net polyline, click on the Link button and then select the

gross polyline.
3. On the warning message box, click Yes.
4. On the information message box, click OK.

You have now linked a net polyline to a gross polyline.

Removing Planon ProCenter data from a polyline

P r o c e d u r e
1. Select Space, Rent to units or Rent from units.
2. Click Unlink.
3. On the warning message box, click Yes.

You have now removed the Planon ProCenter data from the polyline.

 
Press ESC to cancel the linking process or creation process.

 
If your drawing contains unclosed polylines that represent Spaces, Rent to units or Rent
from units, then the outcome of area calculations, available workspace calculations and
copying data from and to spaces might be incorrect. We recommend that your drawing
contains only closed polylines.

Copying data from a space to person or asset

You can copy the department data or cost center data of a space to the persons or
assets located in that space.

P r o c e d u r e
1. Select the Persons or Assets tab.
2. In the drawing, select the person(s) or the assets(s).
3. Click Copy from space.
4. The department and/or cost center values of the space are now copied

to person(s) or asset(s).
5. If the Space contains no value for department and/or cost center, the

value for department and/or cost center of the Person or Asset will not
change.
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Copying data from persons or assets to a space

You can copy department data and cost center data of persons or assets to the space
they are located in.

P r o c e d u r e
1. Select the Persons or Assets tab.
2. In the drawing, select the person(s) or the assets(s).
3. Click Copy to space.
4. The department and cost center values of the person(s) or asset(s) are

now copied to the space.

 
If the department or cost center is not similar for all the selected persons or assets, it is not
copied to the space. Empty values are not considered.

 
If your drawing contains unclosed polylines that represent Spaces, Rent to units or Rent
from units, then the outcome of area calculations, available workspace calculations and
copying data from and to spaces might be incorrect. We recommend that your drawing
contains only closed polylines.

Loading Planon ProCenter data
You can load Planon ProCenter information for entities such as Spaces, Persons,
Assets, Rent to units and Rent from units into Connect for AutoCAD. Some entities
(Spaces, Rent to units and Rent from units ) in the drawing are updated with the values
based on a specified reference date.

Procedure

1. On the Context menu, point to Connect for AutoCAD and select Load
<entity> data.

2. For Spaces, Rent to units and Rent from units, the Set Reference date
dialog box appears.

3. In the Reference date field, specify a date to retrieve the Planon
ProCenter information and click OK.

 
The Set Reference date dialog box does not appear while loading person or asset data.

4. If you select Load asset data, on the Load assets filter dialog, you can
set filters to load assets data based on a classification group.

5. The Loading <entity > data dialog box with a progress bar is displayed
while loading the data.

6. An information message box appears with information about what was
loaded, such as loaded, ended and deleted spaces. Click OK.
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7. Select an entity to view the loaded information.
You have now loaded the Planon ProCenter entity information.

 
We recommend that you use only one property set for a drawing. Load <entity> data will
load only data for entities which have been imported by CAD-import.

 

Rentable units

Spaces

Updating the reference data in a drawing
You can update the reference data in a drawing without having to load the Planon entity
data.

Referenced data in a drawing, for example cost centers, departments or other referenced
data / pick lists, can be updated if the descriptions of this referenced data were changed
in Planon ProCenter. After the update, Connect for AutoCAD will display the changed
descriptions in the drawing.

P r o c e d u r e
1. On the context menu, point to Connect for AutoCAD and select Update

all reference data.
2. After establishing a connection with Planon ProCenter, a confirmation

message which contains the updated reference data is displayed.
3. Click OK.

You have now successfully updated the reference data without loading the Planon entity
data.

Synchronizing the entities location from Planon
ProCenter
You can synchronize the location data of persons and assets (property and space in
which persons or assets are located) from Planon ProCenter to Connect for AutoCAD.

When you synchronize your drawing with Planon ProCenter, entities that are present in
Planon ProCenter but not in the drawing, will be placed in their respective spaces in the
drawing.

First, check the Settings for inserting persons or assets to select an appropriate layer and
block for inserting these entities into a drawing.

 
To synchronize entities from Planon ProCenter to Connect for AutoCAD, you should
assign a space for persons in Personnel Management and a space for assets in Asset
Management. For more information on assigning a space to persons and assets, refer
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to Personnel Management and Asset Management of the Planon ProCenter user
documentation.

P r o c e d u r e
1. On the Context menu, point to Connect for AutoCAD and select

Synchronize person locations to synchronize persons or Synchronize
asset locations to synchronize assets.

2. When synchronizing assets, on the Load assets filter dialog, set the
filter to synchronize relevant assets as described in Managing assets by
filtering on classification group.

3. On the Synchronize person locations or Synchronize assets locations
dialog box, select the appropriate options.

Refer to Synchronize assets locations fields for a brief
description of these options.

4. Click OK to connect to Planon ProCenter to synchronize person or
asset location data.

5. Click OK. Synchronization may take a few minutes to complete. Upon
completion of synchronization, a summary of the synchronization
results is displayed on the information dialog box.

 
After synchronization, an extended log file (.log) with synchronization details is created in
the folder specified in the settings for synchronization logs.

Now, you have synchronized person or asset location data
from Planon ProCenter to Connect for AutoCAD. You will see
the entities inserted on the drawing.

 

Settings for inserting persons or assets

Inserting entities into a drawing

Moving entities
With Connect for AutoCAD, you can move entities such as persons and assets from one
space in a drawing to a space in another drawing.

You can move persons or assets from one drawing to another, by following this
procedure:

P r o c e d u r e
1. Create a new move box.
2. Add entities to a move box from the source drawing.
3. Switch to the destination drawing.
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4. Add entities from a move box to the destination drawing.

Creating a new move box

You can create a new move box:

P r o c e d u r e
1. On the Context menu, point to Connect for AutoCAD and select Palette.
2. On the Palette, click the Persons or Assets tab.
3. In the Move box area, click on the drop-down list and select the first

empty entry.
4. Click on the Add/Edit button to open the Move box details dialog box.
5. Enter a name for the new move box and click Save.

You have now created a new move box. The move box you
have created will be stored at the location specified in Move
box folder settings.

Adding entities to a move box

You can add persons or assets from the drawing to a move box by opening a source
drawing with persons and/or assets in AutoCAD. You can also move the assets related
to persons when you move the persons from the drawing and vice versa to a move box.
Check Settings for moving persons or assets, to move the assets or persons when you
move their related entities.

P r o c e d u r e
1. On the Context menu, point to Connect for AutoCAD and select Palette.
2. On the Palette, click the Persons or Assets tab.
3. In the Move box area, click on the drop-down list and select a move

box.
4. Select one or more persons or assets from the drawing.
5. On the Palette, at the bottom, click on the Add to move box button. The

selected persons or assets are now removed from the drawing and
added to the move box.

You have now added the entities to a move box. The move box that you created will be
saved at the location you specified in Settings for moving persons or assets.

 
If you have set the option to add the personal assets along with persons in the Settings
dialog box, after you click on Add to move box, the related assets of the persons are
subsequently added to the move box along with the persons from the drawing.
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If you have set the option to add owners along with their assets in the Settings dialog box,
after you click on Add to move box, the related owners of the assets are subsequently
added to the move box along with the assets from the drawing.

Viewing and deleting contents of a move box

P r o c e d u r e
1. On the Context menu, point to Connect for AutoCAD and select Palette.
2. On the Palette, click the Persons or Assets tab.
3. In the Move box area, click on the drop-down list and select a move

box.
4. Click on the Add/Edit button to open the Move details dialog box.
5. Select the Persons or the Assets tab.
6. To delete an entity from the move box, select the entity entry and press

Delete on your keyboard.
7. To clear all the persons or assets from the move box, click Clear all.
8. Click Save to save your actions.

 
You can also press Ctrl + Shift on your keyboard and select multiple person or asset
entries.

Filtering entities in a move box

First, create a filter that you want to apply on the move box entities on the Palette.

P r o c e d u r e
1. On the Context menu, point to Connect for AutoCAD and select Palette.
2. On the Palette, click the Persons or Assets tab.
3. In the Move box area, click on the drop-down list and select the move

box to apply a filter on its entities.
4. Click on the Add/Edit button to open the Move box details dialog box.
5. Select the Persons or the Assets tab.
6. From the Filter drop-down list, select a filter.

Click on the  Apply filter button. Based on the filter you have
applied, entities are displayed in the move box. To undo the
filter, select another filter from the drop-down list.

 
If a filter is highlighted in the Filter list box, it indicates that the highlighted filter is already
applied on the entities in the entity tab. To remove the filter, from the Filter drop-down list,
select another filter. This selection will remove the applied filter and will display all the
elements that are in the move box for an entity in the subsequent entity tab.
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Adding entities from a move box to a drawing

You can add entities such as persons and assets from the move box to a drawing by
opening a drawing in AutoCAD to which you want to add the entities.

• Check Settings for moving persons or assets to select an appropriate
layer and block for inserting these entities into a drawing.

• Check Settings for moving persons or assets to move the related
entities of persons and assets if you want to move them from the
move box to a drawing.

Procedure

1. On the Context menu, point to Connect for AutoCAD and select Palette.
2. On the Palette, click the Persons or Assets tab.
3. In the Move box area, click on the drop-down list and select a move box

from which you want to add the entities to the drawing.
4. Click on the Add/Edit button to open the Move box details dialog box.
5. Select one or more entities to add to the drawing (press Ctrl and make

multiple selections) and click on the Add to drawing button.
6. Click on a point in the drawing where you want to insert these entities.

These entities are then removed from the move box and are placed
within a space in the drawing.

 
You can also add entities by clicking at a point outside a space in the drawing and can
later manually assign spaces to each of these entities.

7. Switch to the other tab (Persons or Assets) and repeat step 4 and 5 to
add entities of the other type to the drawing.

8. Click OK or Save after adding the entities to the drawing.

Now, you have added entities from the move box to a
drawing.

 
If you have enabled the options to add related entities of persons and assets in the
Settings dialog box, the related entities of the persons and the assets are added to the
drawing after you click on the Add to drawing button.

Loading a move box with entities from Planon ProCenter

Prior to loading a move box with persons or assets in Connect for AutoCAD, make sure
you do the following in Planon ProCenter.

• In Personnel , select a person from the personnel list or in Assets ,
select an asset from the assets list.
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• In the Move date field, enter the date on which you want to move
the person or asset. The date should be later than or identical to the
current date. If Move date is not available on the layout of Personnel
and Assets , ask your application manager to add this field to the
layout in Layouts .

You can apply a filter on persons or assets based on specific criteria before you load
these entities into the move box from Planon ProCenter.

First, create a filter that you want to apply on the move box entities on the Palette.

 
To know more about adding an optional field to a layout, refer to Customizing a selection
level's layout in the documentation about TSIs .

P r o c e d u r e
1. On the Context menu, point to Connect for AutoCAD and select Palette.
2. On the Palette, click the Persons or Assets tab.
3. In the Move box area, click on the drop-down list and select a move box

on which you want to load entities from Planon ProCenter.
4. On the Move box details dialog box, if you want to load the specific

entities into the move box, select the filter that you created from the
Filter drop-down list.

5. Click on the Load from Planon button.

The entities for which the move date is greater than or equal
to the current date with the specified filter criteria are loaded
into the move box. If you want to remove the filter and load
all the relevant entities, from the Filter drop-down list, select
the blank entry. Now, you can reload the move box with
entities without setting a filter on any of the entities.
Now, you have loaded entities from Planon ProCenter to
the move box. You can also add these entities to another
drawing.

Copying entities
A Planon ProCenter entity (Spaces, Assets, Persons, Rent to units and Rent from units)
can be copied and the information relevant to the copied entity can be specified manually
in the palette.

 
We recommend that you do not use copy-related options such as Copy, Array and Mirror
on the Modify menu in AutoCAD. In case you use them, always perform purging to
remove the additional data of Planon entity information that has been created on your
drawing after you Copy, Array and/or Mirror Planon entities.

P r o c e d u r e
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1. Open the CAD drawing.
2. Select the Planon ProCenter entity you want to copy.
3. On the Edit menu, use the Copy and Paste options or CTRL+C and

CTRL+V respectively.
4. Convert the copied polylines into a Space / Rent to unit / Rent from unit

by Converting polylines as entities.
5. Enter Planon ProCenter information manually to a copied entity.

You have now copied the Planon ProCenter entity.

 
If you make multiple copies of a Planon ProCenter entity, make sure that you change
the relevant information on the Palette manually. This will prevent that the copied entity
causes multiple entries in the drawing database.

Inserting entities into a drawing
Connect for AutoCAD features, such as moving entities using a move box and
synchronizing locations, allow you to insert entities such as persons and/or assets as
block references. Inserting a block reference for these entities is determined by the
following rules:

Persons

When using a move box:

• The block (Applied symbol name) from the move box is used.

• If the block (Applied symbol name) is not present in the target drawing
or in the AutoCAD search paths, the default block that is defined in
Settings for inserting persons or assets is used.

• When synchronizing, the default block that is defined in Settings for
inserting persons or assets is used.

Assets

When using a move box:

• The block (Applied symbol name) from the move box is used.

• If the block (Applied symbol name) is not present in the target drawing
or in the AutoCAD search paths, the block (AutoCAD symbol name)
from the move box is used.

• If the block (AutoCAD symbol name) is not present in the target
drawing or in the AutoCAD search paths, the default block that is
defined in Settings for inserting persons or assets is used.

When synchronizing:

• The AutoCAD symbol name from Planon ProCenter is used.

• If this block is not present in the target drawing or in the AutoCAD
search paths, the default block that is defined in Settings for inserting
persons or assets is used.
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Block Attributes

When you use a move box to move assets and/or persons from one drawing to another,
the block attributes will also be moved. If the block in the target drawing does not contain
the block attributes, you can choose to append these attributes to the block in the target
drawing by checking the option Append new attributes on the Move box dialog box.

 

Synchronizing the entities location from Planon ProCenter

Settings for inserting persons or assets

Updating space data blocks
You can store space data in block attributes which are placed inside the spaces in a
drawing. This will also allow the users of DWG viewer to see the space data on the
drawing.

Procedure

1. Go to the Context > Connect for AutoCAD menu.
2. Select Analyze drawing, to analyze the drawing structure.
3. On the Context > Connect for AutoCAD menu, select Palette.
4. On the Palette, click the Spaces tab.
5. In the Data block link section, click the Add/Edit button.
6. On the Data block details dialog box, select a Layer and a Block from

the drop-down list, to define the block, layer and field relation.
7. In the Fields and attributes section, select a field name from the

Available list.
8. In the Attribute tags column, select a block attribute to map it onto the

selected field name.

Click the  button to map the selected field name and the
block attribute.

9. You can map the relevant fields onto the available block attributes for
the block you selected from the drop-down list.

10. Click Save.
11. Click the Apply button.

The space block data in the selected space layer is updated. The space block
definitions are stored at the following location: C:\Documents and Settings
\<User directory>\Application Data\Planon\Planon Connect for AutoCAD
\BlockDefinitions
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Managing assets by filtering on classification group
For assets, you can specify a classification group(s) in order to limit the assets that you
want to manage in your drawing. By setting a filter on a classification group, only the
assets of the selected group(s) will be loaded or synchronized.

You can also set a default asset (group) filter while loading and synchronizing assets.

Procedure

1. On the Context menu, point to Connect for AutoCAD and select Load
asset data or Synchronize asset locations.

2. On the Assets filter dialog, you can specify a filter for the asset.
3. Check the Filter on classification group option to view the list of

available classification groups.
4. Move the classification groups from the Available section to the In use

section.
5. Select Ignore or Delete to retain or remove Planon data of other assets

on the drawing when you load or synchronize assets.

 
To load your default asset filter, click the Load default asset filter button on the Asset filter
dialog and click OK.

6. Click OK to continue with Load asset data or Synchronize asset
locations.

You have now set filters to classify assets that you want to
manage on the drawing.

 
If you do not want to set a filter, for example if you want to manage all the assets
irrespective of their classification group, uncheck Filter classification group and click OK
to continue with Load asset data or Synchronize asset locations.

Analyzing drawings
If your drawing consists of nested entities, use the Analyze drawing feature to make sure
that the area calculation and hatching is correct for the nested entities.

Nested entities can be spaces, holes or constructional elements. They exist as space
within a space or an excluded area in a space. Therefore, when calculating the area and
hatching of spaces, all these type of nested entities are taken into account.

If you have applied a Space Norm during CAD Import, the threshold values as specified
in that Space Norm will also be applied in Connect for AutoCAD.

P r o c e d u r e
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1. In the Context menu, point to Connect for AutoCAD and select Analyze
drawing.

There are two ways to analyze a drawing:
◦ Manual analysis

◦ Automatic analysis

For Manual analysis select Analyze drawing. An information
message box appears after completing the analysis.

2. For Automatic analysis in Settings, select General and select
Automatically analyze drawing. This option automatically analyzes the
drawing before saving.

 
If your drawing contains unclosed polylines that represent Spaces, Rent to units or Rent
from units, then the outcome of area calculations, available workspace calculations and
copying data from and to spaces might be incorrect. We recommend that your drawing
only contains closed polylines.

Deleting Planon ProCenter data (Purging)
You can delete additional entries of Planon ProCenter entity information that are copied,
arrayed, and/or mirrored in the drawing.

In the Context menu, point to Planon and select Purge Planon data.

You can purge Planon data in two ways:

Manual purging

1. Select the Purge Planon data option. A dialog box appears that shows the
number of deleted records.

2. Click OK.
Automatic purging

1. In Settings, select the General tab and select the Automatically Purge Planon
data checkbox. This option automatically deletes the unused data while
saving a drawing without displaying any information.

2. Click OK.
You have now deleted the unused information.

Configuring settings
To configure settings for Connect for AutoCAD, use the following procedure:

1. Go to the Context menu.
2. Point to Connect for AutoCAD and select Settings.
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The Settings window appears.

General settings

If you want to specify the general settings, select the General tab and complete the
relevant fields in the dialog box. Refer to General settings fields for the descriptions.

Adding and sorting fields

You can add and sort fields for an entity on the Palette. This setting is specific to your
computer.

P r o c e d u r e
1. Select the entity tab for which you want to sort fields.

In the Palette fields area, select a field from the Available

section and click the  right arrow to move the field to the
Visible section.

2. In the Visible section, you can sort the fields as required. You can use
the buttons on the right side of the dialog box to rearrange the position.

3. Click OK.

You can view the fields in the same order as you would like to see them on the palette
as well as on the filter dialog boxes. The selected order will also be applied in the move
boxes.

Highlighting the selected entity

P r o c e d u r e
1. In the Highlighting section, check the option Automatically highlight

current selection to highlight the selected entities of a drawing with the
selected mapping file criteria.

2. Specify a Mapping file to highlight the selected entity with the hatch and
color of the mapping file.

3. Click OK. This setting is specific to your computer.

 
The mappings that are created in the Mapping field on the Palette are listed in Mapping
file drop-down box in this section.

 
For more information on mapping, refer to Creating mappings.
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Mapping settings

You can make legend and mapping settings for all the entities in a drawing.

P r o c e d u r e
1. Select an entity tab for which you want to configure the mapping

settings.
2. Complete the relevant fields in the mapping area. Refer to Mapping

setting fields for the description.
3. Click OK.

You have now specified a location for the legend and configured the text size in a
drawing for an entity.

Settings for inserting persons or assets

You can specify a layer and a block to insert one or more persons or assets into a
drawing, while moving and synchronizing entities. This setting is specific to your drawing.

P r o c e d u r e
1. In the Settings dialog box, select the Persons or Assets tab.
2. From the layer drop-down list, select a layer.
3. From the block drop-down list, select a block.
4. Click OK to save your settings.

 
If a block appears too small or too large after inserting a person or an asset, please check
your block unit and drawing unit. We recommend that you use identical units for drawing
and block.

 

Synchronizing the entities location from Planon ProCenter

Inserting entities into a drawing

Settings for moving persons or assets

You can specify a location for saving move boxes.

P r o c e d u r e
1. In the Settings dialog box, select the Persons or Assets tab.
2. Specify a folder path to save the move boxes. This folder can exist

anywhere on your computer.
3. Select the General tab.
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4. Select the Move personal assets along with persons and the Move
owners along with their assets options to move the related entities of
persons or assets from the move box to a drawing and from a drawing
to the move box.

5. Click OK to save your settings. This setting is specific to your computer.

Settings for synchronization logs

You can specify a location to save synchronization logs.

P r o c e d u r e
1. In the Settings dialog box, select the Persons or Assets tab.
2. Specify the folder path to save the synchronization logs. This folder can

exist anywhere on your computer.
3. Click OK to save your settings. This setting is specific to your computer.

 
If the content of a synchronization log contains Unicode characters, you must set the
encoding to UTF-8 in the viewer to view Unicode characters.

Settings for default asset filters

You can specify default settings for loading and synchronizing assets.

P r o c e d u r e
1. In the Settings dialog box, select the Assets tab.
2. Click the Default asset filter button.
3. On the Assets filter dialog, you can specify a filter for the asset.
4. Check Filter on classification group option to view the list of available

classification groups.
5. Move the classification groups from the Available section to the In use

section.
6. Select Ignore or Delete to retain or remove Planon data of other assets

on the drawing when you load or synchronize assets.
7. Click OK to save your settings. This setting is specific to your computer.
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Commands in Connect for
AutoCAD

Use the following commands in the command line window of C to perform relevant tasks
in Connect for AutoCAD.

Command Action

plnAbout Opens the About window

plnAnalyzeDrawing Analyzes the drawing in order to activate area
calculation of nested or enclosed entities.

plnLoadAssetData Loads Planon asset data

plnLoadLettableUnitData Loads Planon rent from unit data

plnLoadPersonData Loads Planon person data

plnLoadRentableUnitData Loads Planon rent to unit data

plnLoadSpaceData Loads Planon space data

plnPalette Loads the Palette

plnPaletteAssets Switches to the Assets tab if the Palette is open

plnPaletteClose Closes the Palette

plnPaletteLettableUnits Switches to the Rent from units tab if the Palette
is open

plnPalettePersons Switches to the Persons tab if the Palette is open

plnPaletteRentableUnits Switches to the Rent to units tab if the Palette is
open

plnPaletteSpaces Switches to the Spaces tab if the Palette is open

plnPurge Purges Planon data
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Command Action

plnSelectionMode Activates either the AutoCAD mode or CAD
Integrator mode to select the entities of a
drawing.

plnSettings Opens the Settings dialog box

plnSynchronizeAssets Synchronizes Planon asset data

plnSynchronizePersons Synchronizes Planon person data
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Connect for AutoCAD – Field
Descriptions

Mapping fields

Field Description

General area  

Mapping name Enter a name for the mapping.

Map on field Specify a field to map. For example, Department or
Space standard.

 
In Connect for AutoCAD you can specify the maximum
level of detail for Department and Space standard
(LVL1, LVL2, LVL3). This means that all Departments
(or Space standards) on a lower level than selected,
will be grouped together to this maximum level of
detail.

Include entities without
value

Select the check box to include entities that do not
have a value for the selected field.

For example, this option highlights the spaces which
are not linked to a department.

 
If you select this check box, the Color for entities
without value option becomes available in the
Coloring area. Specify a color to highlight the entities
without a value. This option is disabled for Available
workspaces (drawing) and Available workspaces
(Planon) fields.

Legend area  

Show legend Select this check box to show a legend in the
mapping.

Legend title Enter a header name for the Legend to display as
title in the drawing.

Coloring area  

Coloring type From the drop down list, specify a coloring type.
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Field Description

 
If you select Fixed Color type, the Color field becomes
available. All the elements will get the same (selected)
color. The Planon color type is visible only when
the field selected in the Map on field section has a
Planon color associated with it. If you select AutoCAD
Color Index, random colors are applied based on the
AutoCAD schema. 
If you set the coloring type to Planon color for fields
such as Department and Cost center that have a color
linked in Planon ProCenter, the entities associated
with these fields (Department and Cost center) will
display the defined colors in Planon ProCenter after
performing mapping on these fields. This option is
disabled for Available workspaces (drawing) and
Available workspaces (Planon) fields since they have
fixed coloring patterns. For more information, refer to
Mapping.

Color Specify a color to highlight the entities (if you have
selected Coloring type as Fixed color).

Color for entities
without value

Specify a color to highlight the entities without a
value.

Hatch area  

Show hatch Select the check box to show hatching in the
mapping.

Hatching type Select one of the following options to indicate the
hatching type:

• Planon hatch pattern - The
hatch pattern is automatically
picked from the color and
hatching fields in Spaces.
For more information, see
Spaces > Space mapping per
department or department
level.

• AutoCAD hatch pattern - If
you select this option, the
hatch pattern is taken from
the fields Pattern, Scale and
Angle.

Pattern In the Hatch pattern palette dialog box, select a
pattern to hatch.
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Field Description

Scale Specify a scale for the hatch pattern.

Angle Specify an angle for the hatch pattern.

Scale correction
method

Select one of the following options to indicate the
correction method for the scale:

• Manual correction factor -
By selecting this option, you
must enter the correction
factor manually in the field
Correction factor.

• Planon correction factor
- The correction factor is
automatically picked from
the field Floor hatch scale
in Floor attributes. For more
information, see Spaces >
Floor attributes fields.

Correction factor Enter a number for the hatch pattern correction
factor. The minimum value is 0 and there is no
maximum value. Based on this number, the
hatch pattern is displayed on the CAD drawing.
The larger the number the greater the distance
between the hatch lines. This field is enabled only if
Manual correction factor is selected in the Scale
correction method field.

 
For Person and Asset mappings the hatch area is disabled, because Blocks cannot be
hatched.

Synchronize assets locations fields

Field Description

Persons not located on
this floor in Planon or
Assets not located on
this floor in Planon

You can choose to perform one of the following
actions on persons or assets present in your
drawing, but which are not located on that floor in
Planon ProCenter.

Ignore: Retain persons or assets in the drawing.

Delete: Delete persons or assets from the drawing.

Add to move box: Remove persons or assets from
the drawing and add them to a move box. Select a
move box from the drop-down list.
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Field Description

Load Planon data for
inserted persons or
Load Planon data for
inserted assets

By selecting this option, the Planon ProCenter
person or asset data will be loaded for persons or
assets who are newly inserted in the drawing.

General settings fields

Field Description

Language Specify a language for Connect for AutoCAD.

 
Restart AutoCAD, to activate the selected language.
This setting is specific to your computer.

Scale factor Specify a value to convert the existing measurement
unit used in your drawing into a new unit. This
setting is specific to your drawing.

Simultaneously, update the settings for the Legend
unit field with the new unit. The converted value with
the relevant unit is displayed on the palette.

Example: Assume that the existing unit for your
drawing is in inches. To convert from inches to
meter, specify the conversion rate of 0.0254 (1 inch
= 0.0254 meter), in the Scale factor field. Now,
when you select a space, you will find that the unit
for area is displayed in square meters in the legend
and also on the palette.

Legend unit Specify a measurement unit. This unit appears
both on the palette and in the legend of a drawing.
The selected units are displayed as m2 or ft2
respectively. This setting is specific to your drawing.

Decimal precision Select an appropriate decimal point value (i.e. the
number of digits following the decimal point) from
the drop down list, to display the accurate value in
the fields related to Area on the Palette and on the
legend after Mapping. This setting is specific to your
computer.

Planon ProCenter url Specify the SDK URL of Planon ProCenter to
allow Connect for AutoCAD to retrieve values, for
example:

http://WebServerName:portnr/sdk
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Field Description

or, for cloud environments:

https://yourenvironment.planoncloud.com/sdk/

Selection mode Select AutoCAD mode to use the AutoCAD way of
selecting entities in a drawing.

Select CAD Integrator mode to select the entities
by a single mouse click at any point inside the
polyline. This setting is specific to your computer.

Automatically purge
Planon data

Select the checkbox to delete the additional entries
of entity data while saving a drawing. This setting is
specific to your computer.

Automatically analyze
drawing

Select the checkbox to analyze a drawing while
saving a drawing. This setting is specific to your
computer.

 
It is possible that your AutoCAD drawings have an underlying structure which prevents the
“CAD integrator selection mode” to work correctly. In that situation you have to switch to
AutoCAD selection mode.

Mapping setting fields

Field Description

Legend text height Specify a height for the text in the legend.

Text height Specify a height for the mapping text.

Legend insert point Specify an insert point to locate legend in the
drawing. The insertion point updates the values of
the X – axis and Y – axis accordingly.
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